
 

GolfSoc Help  Updated 15/03/2023 Page 1 
 

GolfSoc 

 
 

Golf Society Plugin for Wordpress  

 

 

User Guide 

 



 

GolfSoc Help  Updated 15/03/2023 Page 2 
 

Contents 
1 Introduction.................................................................................................................................... 4 

1.1 Purpose ............................................................................................................................... 4 

1.2 Admin Features ................................................................................................................... 4 

1.3 Shortcode Output Features ................................................................................................. 4 

2 Prerequisites ................................................................................................................................... 5 

2.1 Website hosting with Wordpress Installed .......................................................................... 5 

2.2 Wordpress Plugins .............................................................................................................. 5 

3 Installation ...................................................................................................................................... 6 

3.1 First Time Installation ........................................................................................................ 6 

3.2 Manual Upgrade ................................................................................................................. 6 

3.3 Auto Update ........................................................................................................................ 6 

3.4 Settings ................................................................................................................................ 6 

4 Settings ............................................................................................................................................ 7 

4.1 General Settings .................................................................................................................. 7 

4.2 Golf Settings ........................................................................................................................ 8 

4.3 EMail Settings ..................................................................................................................... 8 

4.4 Page Template Settings ....................................................................................................... 9 

5 Using the Admin Pages ................................................................................................................ 11 

5.1 Players Admin Page .......................................................................................................... 11 

5.2 Courses Admin Page ......................................................................................................... 13 

5.3 Competitions Admin Page ................................................................................................. 15 

5.4 Handicaps Admin Page ..................................................................................................... 18 

6 Shortcodes .................................................................................................................................... 19 

6.1 Summary Page .................................................................................................................. 19 

7 Capabilities ................................................................................................................................... 20 

7.1 Overview ........................................................................................................................... 20 

7.2 GolfSoc Role ..................................................................................................................... 20 

7.3 GolfSoc Capabilities ......................................................................................................... 20 

8 Advanced Customisations ........................................................................................................... 21 

8.1 EMail Templates ............................................................................................................... 21 

8.2 Page Templates ................................................................................................................. 21 

8.3 EMail Logo Image ............................................................................................................ 21 

8.4 Template Files ................................................................................................................... 22 

9 Translation ................................................................................................................................... 23 

9.1 Overview ........................................................................................................................... 23 



 

GolfSoc Help  Updated 15/03/2023 Page 3 
 

9.2 Location of Language Files .............................................................................................. 23 

9.3 Tools .................................................................................................................................. 23 

9.4 Translating With Poedit .................................................................................................... 23 

9.5 Updating the .PO file ........................................................................................................ 24 

 



 

GolfSoc Help  Updated 15/03/2023 Page 4 
 

1 Introduction 

1.1 Purpose 

GolfSoc is a Wordpress plugin intended for use by organisers of Golf Societies. It 
stores details of players, courses, competitions and results. In addition it 
calculates handicaps. 

1.2 Admin Features 

The following admin features are available: 

• Players list with contact details and EMail addresses. 

• Courses list with tee details  

• Past and future competitions list with tee details 

• Results list with playing handicaps 

• Calculation of revised Handicap Indexes 

• Handicap Indexes list 

• Generates and sends EMails for result and handicap notifications 

1.3 Shortcode Output Features 

The following can be output from a WordPress page that includes the GolfSoc 
shortcode: 

• Summary page with current Handicap Index, No of Competitions played, 
Last Competition Location and Date/Time 

• Recent Handicap history (via link from Summary) 

• Full Handicap archive (via link from Summary) 

• Last Round scores (via link from Summary) 

• Players Competition record 

• Competitions Archive 
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2 Prerequisites 
To use GolfSoc the following system prerequisites are required: 

2.1 Website hosting with Wordpress Installed 

The target website must have Wordpress set-up and working. 

For correct operation of GolfSoc the “Time zone”, “Date Format” and “Time 
Format” entries on the Wordpress Settings-General admin page must be set to 
appropriate values. If these settings are incorrect, time or daylight saving 
discrepancies, or formatting errors can occur. 

2.2 Wordpress Plugins 

The appropriate GolfSoc plugin must be downloaded, installed and activated. 

An EMail Client plugin may also be required. The author recommends either “WP 
Mail SMTP” or “Fluent SMTP”. 

The “User Role Editor” plugin is also recommended for use with GolfSoc plugins. 
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3 Installation 

3.1 First Time Installation 

To install a GolfSoc plugin proceed as follows: 

• Download the GolfSoc plugin archive 

• Open the Wordpress Dashboard for you site 

• Select the "Upload" option  

• Click "Add New" under the "Plugins" menu  

• Under "Install a plugin in .zip format" browse to the GolfSoc plugin archive 
file you downloaded 

• Click Install Now. 

• After it has installed, activate the plugin. 

3.2 Manual Upgrade 

The GolfSoc plugin can be manually updated or reinstalled without changing its 
settings or database entries (Players, Courses, Competitions and Scores) by 
following the procedure below.  

• Take a full backup of your site 

• On the WP “Installed Plugins” admin page deactivate GolfSoc 

• Using FTP (or your ISPs file manager) delete the GolfSoc plugins folder in 
wp-content/plugins folder 

• Reload the WP “Installed Plugins” admin page. Wordpress will report that 
the plugin file could not be found and that the plugin has been 
deactivated. 

• Now Proceed as for the First Time Installation 

Note:  

• Do not delete GolfSoc using the “Installed Plugins” admin page as this 
deletes all its database tables and settings, including details of any 
scores, associated with GolfSoc.  

3.3 Auto Update  

GolfSoc is integrated into the standard Wordpress plugin update mechanism, and 
updates will be shown when available on the Wordpress Dashboard. 

Note:  

• Any communication errors with the update server, or errors in sale 
confirmation are shown on the “Installed Plugins” page, and on the 
GolfSoc Overview page. 

3.4 Settings 

Once the plugin is installed and activated, its’ settings must be reviewed and 
saved before the plugin can be used. See the next section for details. 
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4 Settings 

4.1 General Settings 

4.1.1 Society ID 

The name of the Golf Society as it will appear on EMails and the output from the 
plugin shortcode. 

Default: The Wordpress Site Title 

4.1.2 Site Logo Image File 

The logo that will appear on the login page (when generated by plugin shortcode 
output). 

Default: Golfsoc Site Logo 

4.1.3 EMail Logo Image File 

The logo that will be used in EMails generated by the plugin. 

Default: Golfsoc EMail Logo 

4.1.4 Items per Page 

The maximum number of rows that will be displayed on an admin page that has 
paged output. 

Default: 20 

4.1.5 Player Names Format 

The order that first name and last name will be displayed on admin pages.  

Default: First Name, Last Name 

4.1.6 Player Role 

The Role that will be assigned to any new players. This will be added to 
Wordpress if it does not already exist. 

Default: Golfer 

Note:  

• If this is changed only players added after the change will be assigned the 
updated role.  

4.1.7 Template Data 

When this option is selected a text dump of the database data, that can be used 
by a template, is added to the output. For EMails this option is only enabled when 
the destination email is the admin email, and for shortcode output it is only 
enabled when a user with admin capability is logged in. 

Default: Unchecked 
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4.2 Golf Settings 

4.2.1 Max Results in Handicap Record 

The maximum number of recent results that are checked in the calculation of 
players handicap. When a player has less than this number of results, then all the 
results they have will be checked. 

Default: 20 

4.2.2 Averaged Results for Handicap 

The number of results that are averaged to calculate a players handicap. When a 
player has less than this number of results, then their Handicap Index will be 
calculated from all the results they have. 

Default: 4 

4.3 EMail Settings 

4.3.1 Admin EMail  

The EMail address that will be used as the “from” EMail address for all emails 
sent by GolfSoc. 

Default: The Wordpress Administration EMail Address 

4.3.2 Bcc EMails   

When checked adds a BCC to the Admin EMail will be added to every email sent 
by the plugin. 

Default: Checked 

4.3.3 Bulk EMail Interval (secs)  

When GolfSoc sends EMails to multiple recipients, the output is “throttled” with a 
delay between each email being sent. This setting determines the interval (in 
seconds) between each EMail being sent. 

Default: 5 

4.3.4 Missing EMail Domain  

GolfSoc uses the standard Wordpress users system to record users details. This 
requires all users to have a registered email address. GolfSoc allows players to 
be added that do not have an email address, so for these users the email 
address is set as follows:  

{firstName}.{lastName}@{missingDomainName} 

Default: golfsoc.noemail.address  

4.3.5 EMail MIME Encoding 

GolfSoc creates EMails in MIME encoded format. This encoding can either be 
done by the Wordpress code (PHPMailer) or by code included with the plugin. 
This option should only be changed if problems with EMail deliverability are 
experienced. 
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4.3.6 PH EMails Target 

This setting determines if Playing Handicap Notification EMails are sent to “All 
Players” or to “Active Players”. 

Default: Active Players 

4.3.7 Playing Handicaps EMail Template 

The template used for Playing Handicap Notification EMails.  

Default: golfsoc_ph_HTMLEMail 

4.3.8 Scores & Handicaps EMail Template 

The template used for Score and Handicap Notification EMails.  

Default: golfsoc_hcap_HTMLEMail 

4.4 Page Template Settings 

4.4.1 Summary Page Template  

This option specifies the page template for the summary page output generated 
in response to the plugin shortcode. 

Default: golfsoc_summary_HTML 

4.4.2 Handicap History Page Template 

This option specifies the page template for the handicap history page output 
generated in response to the plugin shortcode. 

Default: golfsoc_hcaphist_HTML 

4.4.3 Handicap Archive Page Template  

This option specifies the page template for the handicap archive page output 
generated in response to the plugin shortcode. 

Default: golfsoc_hcaparch_HTML 

4.4.4 My Competitions Page Template  

This option specifies the page template for the player competitions page output 
generated in response to the plugin shortcode. 

Default: golfsoc_mycompetitions_HTML 

4.4.5 All Competitions Page Template 

This option specifies the page template for the all competitions page output 
generated in response to the plugin shortcode. 

Default: golfsoc_allcompetitions_HTML  

4.4.6 Scores Page Template  

This option specifies the page template for the scores page output generated in 
response to the plugin shortcode. 

Default: golfsoc_scores_HTML 
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4.4.7 Course Rating Page Template  

This option specifies the page template for the course rating page output 
generated in response to the plugin shortcode. 

Default: golfsoc_rating_HTML 

4.4.8 Playing Handicap Page Template 

This option specifies the page template for the playing handicaps page output 
generated in response to the plugin shortcode. 

Default: golfsoc_playinghandicaps_HTML 
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5 Using the Admin Pages 
This section details how to add players, courses, competitions and scores to your 
website and how to update handicap indexes. In general these admin screens will 
be used in the order they appear in the GolfSoc menu (and the order in this 
document). 

5.1 Players Admin Page 

This page shows the list of players that have taken part in the societies 
competitions, or that may take part in the future.  

5.1.1 Adding a new player 

New players may be added to this list by a system administrator by clicking the 
“Add Player” button and then completing the entries on the form that is displayed.  

5.1.1.1 First Name 

The new players first name as it will be shown in plugin output. 

5.1.1.2 Last Name 

The new players last name as it will be shown in plugin output. 

5.1.1.3 Gender 

The new players gender which will be used to select which tee they will play from. 

5.1.1.4 EMail 

The new players EMail address. This may be left blank in which case a default 
email address (see section 4.3.4) will be used.  

5.1.1.5 Phone 

The players phone number. 

5.1.1.6 Mobile 

The players mobile number. 

5.1.1.7 Handicap 

An initial handicap index for the player. 

Note:  

• When a player is added, GolfSoc attempts to match the email address 
with an existing Wordpress user account. If a match is found, and the first 
and last name match that account, then the new player will be linked to 
that account. If there is no match for the EMail then a new Wordpress 
account will be created. 

• The first name, last name and EMail address of a player can be changed 
either from the players list (see section ) or by editing the profile of the 
Wordpress account linked to that player (which the player can do 
themselves). 
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• Players without a valid email address will lose the ability to reset their own 
password. 

5.1.2 The Players List 

The Players Admin page shows the list of all players that have been added to the 
GolfSoc database. It has the following columns: 

5.1.2.1 Active or Inactive 

Players can be marked as “Active” or “Inactive” and a filter at the top of the list 
allows which of these should be displayed. Admin users can change the active 
state of one of more players in the list by using the row select check boxes and 
then the “Bulk Actions” selector followed by the “Apply” button. Inactive players 
may (optionally) also be excluded from EMail notifications (see section 4.3.6). 

5.1.2.2 Deleting a Player 

The “Bulk Actions” selector can also be used to delete a player. Only a player that 
has no scores entered can be deleted. 

5.1.2.3 Editing a Player 

The players details can be edited by clicking on either their name or EMail 
address in the Players List. 

5.1.2.4 Scores Record 

The scores record for a player can be viewed by clicking on the number of scores 
shown in the players list. 
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5.2 Courses Admin Page 

The Courses admin page shows the list of courses that have been used for in a 
competition, or may be used in the future. This list also includes details of tees, 
with corresponding Course Rating, Slope Rating and Par values.   

5.2.1 Adding a new course 

New players may be added to this list by a system administrator by clicking the 
“Add Course” button and then completing the entries on the form that is 
displayed.  

5.2.1.1 Course Name 

The name of the course. The minimum length of the name is pre-defined within  
the GolfSoc code, but this can be changed using a constant defined in the 
Wordpress wp-config.php file (see section Error! Reference source not found. 
for details). 

5.2.1.2 Address 

The address of the course can (optionally) be entered and can then be included 
in page output (if included in the page template). 

5.2.1.3 Postcode 

The postcode of the course can (optionally) be entered and can then be included 
in page output (if included in the page template). 

5.2.1.4 Phone 

The phone number of the course can (optionally) be entered and can then be 
included in page output (if included in the page template). 

5.2.1.5 W3W 

The “What 3 Words” entry for the course can (optionally) be entered and if this is 
used in the page output this can be converted in a link to a map page. (if included 
in the page template). 

5.2.2 Add Course Tees 

When the new course is added, a second form is shown which allows details of a 
tee to be added to the course. Once the details below have been added click 
“Save Tee” to add the tee to the course. This process can be repeated to add 
extra tees to the course. 

5.2.2.1 Tee 

The tee colour. The range of tee colours offered is pre-defined within  the GolfSoc 
code, but this can be changed using a constant defined in the Wordpress wp-
config.php file (see section Error! Reference source not found. for details). 

5.2.2.2 Holes 

The number of holes to be played. 

5.2.2.3 Par 

The par for the course played from this tee. 
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5.2.2.4 Course Rating 

The course rating for the course played from this tee. 

5.2.2.5 Slope Rating 

The slope rating for the course played from this tee. 

Note: 

If a tee is added when one of the same colours has already been defined, then 
the new entry will replace the original and any competitions added from then on 
will use the new values. Any existing unplayed competitions will have the option 
to use the tees in force when they were added or to use the new values. 

5.2.3 The Courses List 

The Courses Admin page shows the list of all courses that have been added to 
the GolfSoc database. It has the following columns: 

5.2.3.1 Name 

The name of the course 

5.2.3.2 Address 

The address of the course 

5.2.3.3 Tees 

The number of tees that have been added to the course details. A list of these 
can be viewed by clicking the “Show” button. 

5.2.3.4 Tee  

The colour assigned to the tee. 

5.2.3.5 Gender 

The gender of players that will play from this tee. 

5.2.3.6 Par 

The par when playing from this tee. 

5.2.3.7 Course Rating 

The course rating when playing from this tee. 

5.2.3.8 Slope Rating 

The slope rating when playing from this tee. 

 

5.2.4 Deleting a Course 

The “Bulk Actions” selector can be used to delete a course. Only a course that 
has no competitions can be deleted. 

5.2.5 Editing a Course 

Course entries can be edited by clicking the “Edit Course” button. The available 
entries are the same as the “Add Course” entries. 
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5.3 Competitions Admin Page 

The Competitions admin page shows the list of competitions that have been 
already been played, or that will be played in the future. New competitions may 
be added to this list by a  system administrator. 

5.3.1 Adding a new competition 

New players may be added to this list by a system administrator by clicking the 
“Add Competition” button and then completing the entries on the form that is 
displayed.  

5.3.1.1 Course Name 

This drop-down box gives a list of all the courses that have been added to the 
GolfSoc database. The course that the competition will be played at should be 
selected from the list. 

5.3.1.2 Date & Time 

The date and time of the first tee time for the competition. 

5.3.1.3 Format 

The format of the competition.  

Note: 

• Currently only Stapleford competitions are supported. 

5.3.2 Add Competition Tees 

Once the details above have been entered a second form is displayed which 
allows the tees to be used to be selected.  

5.3.2.1 Men Tee 

A drop-down box allowing the men’s’ tee to be selected 

5.3.2.2 Ladies Tee 

A drop-down box allowing the ladies’ tee to be selected 

5.3.3 The Competitions List 

The Competitions Admin page shows the list of all competitions, past and future 
that have been added to the GolfSoc database. It has the following columns: 

5.3.3.1 Date & Time 

The date and time of the first tee time for the competition. 

5.3.3.2 Course 

The name of the course the competition will be played on. 

5.3.3.3 Format 

The format of the competition.  
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5.3.3.4 Scores 

The number of scores that has been entered for this competition. 

5.3.3.5 Action  

This column shows an action button which differs according to the current status 
of the competition.  

For competitions where the current date is before the date of the competition a 
“Send Handicaps” button will be shown. See section 5.3.4 for a description of 
what this does. 

For competitions where the current date is on of after the date of the competition, 
and the competition has not been closed, a “Add Scores” button will be shown. 
See section 5.3.5 for a description of what this does. 

For competitions where the competition has been closed, a “Show Scores” button 
will be shown. See section 5.3.6 for a description of what this does. 

5.3.4 Sending Playing Handicaps 

This action allows an admin user to send a playing handicaps notification for the 
relevant competition to a selected group of players.  

When the button is clicked a list of players is displayed, and the admin can select 
which players are to receive the notification by selecting a checkbox on the left 
column of each row. The list of players will be either ‘Active’ players or all players 
depending on what has been selected in the settings (see section 4.3.6). 

Once the players have been selected, clicking on the “Send EMails” will start the 
process of sending the emails. The count of EMails sent will be updated as they 
are sent, and will change to ‘All’ once all have been sent. 

Notes: 

• The Playing Handicaps Notifications will use the EMail template defined in 
the relevant entry in the settings (see section Error! Reference source 
not found.). 

• Multiple EMails are sent at regular intervals, where the interval is 
determined by an entry in the settings (see section 4.3.3). 

5.3.5 Adding Scores 

This action allows an admin user to add the scores for a competition. When the 
button is clicked it brings up a form with the following fields: 

5.3.5.1 Player 

The player that you want to post a score for. Only ‘Active’ players will be listed 

5.3.5.2 Playing Handicap 

The playing handicap that the player used for this competition. This will be pre-
loaded with the Playing Handicap calculated by GolfSoc, but this can be changed 
if the player used a different playing handicap. 

5.3.5.3 Score 

The score for this player and this competition 
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5.3.5.1 Countback 

An optional value that will determine the finish order where players scores are 
identical. Players with the same score will be sorted in descending order of 
countback values. 

5.3.5.2 Add Score 

Click the “Add Score” button to add all the scores that you have entered. 

5.3.5.3 Closing the Competition  

The “Close Competition” button is shown when the form is first shown. Click on 
this button to close the competition, publish the results on the website and 
calculate new handicaps. 

5.3.5.4 Sending Results EMails 

When the competition is closed using the “Close Competition” button (as in 
section 5.3.5.3 above) a list of players is displayed, and the admin can select 
which players are to receive a result notification by selecting a checkbox on the 
left column of each row.  

Once the players have been selected, clicking on the “Send EMails” will start the 
process of sending the emails. The count of EMails sent will be updated as they 
are sent, and will change to ‘All’ once all have been sent. 

Notes: 

• The Scores and Handicaps Notifications will use the EMail template 
defined in the relevant entry in the settings (see section Error! Reference 
source not found.). 

• Multiple EMails are sent at regular intervals, where the interval is 
determined by an entry in the settings (see section 4.3.3). 

5.3.6 Showing Scores 

This action allows an admin user to view the scores for a competition. When the 
button is clicked it brings up a table with the following fields: 

5.3.6.1 Player 

The player that the score is for. 

5.3.6.2 Tee 

The tee that the player played from. 

5.3.6.3 Playing Handicap 

The playing handicap that the player used for this competition. 

5.3.6.4 Score 

The score for this player and this competition 
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5.4 Handicaps Admin Page 

5.4.1 Handicaps List 

The Handicaps Admin page shows the list of current handicaps in the GolfSoc 
database. A filter at the top of the list controls what players “Active” state entries 
should be displayed. It has the following columns: 

5.4.1.1 Name 

The name of the player. 

5.4.1.2 Handicap Index 

The players current handicap index. 

5.4.1.3 Updated 

The date when the Handicap Index was last updated. 
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6 Shortcodes 
GolfSoc displays output on a Wordpress Page or Post in response to a 
Wordpress Shortcode (a text sequence enclosed by square brackets) defined by 
the plugin code.  

A list of the available shortcodes for GolfSoc is on the GolfSoc Overview admin. 

6.1 Summary Page 

The Summary page can be output on a Page or Post by adding the following 
shortcode: 

 [golfsoc-sc] 

Using the default template, this will output the name of the currently logged in 
player, their current handicap. number of rounds played, and the last round 
played. These entries have links to other pages giving more details. 
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7 Capabilities 

7.1 Overview 

When activated GolfSoc adds a custom “Role” and some custom “Capabilities” to 
the Wordpress site. These are then all enabled for the Administrator role. These 
Capabilities can be used to control access to GolfSoc admin pages by users. 

7.2 GolfSoc Role 

GolfSoc adds its’ own custom “Role” to WordPress when it is installed. The role 
name is defined by the GolfSoc settings (see section 4.1.6). 

7.3 GolfSoc Capabilities 

The capabilities for a particular user can be edited from the Wordpress Users 
admin menu page, or by installing and using the “User Role Editor” plugin for 
WordPress. The following custom capabilities are supported: 

7.3.1 GolfSoc_Player 

Enabling this capability gives the user access to the GolfSoc shortcode output. 

7.3.2 GolfSoc_Admin 

Enabling this capability for a user gives them access to all GolfSoc admin pages 
except for the settings page. 

7.3.3 GolfSoc_Settings 

Enabling this capability for a user gives them access to the GolfSoc settings 
page. 
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8 Advanced Customisations 
A number of advanced customisations that may involve the use of external 
editors, or a knowledge of HTML and CSS can be added to GolfSoc installations.  

8.1 EMail Templates  

GolfSoc generates emails based on template files. Default template files are 
included in the GolfSoc distribution, and are copied to a working copies when the 
plugin is activated or updated. These copies of the email templates are located in 
the following working folder: 

{Your-site}/wp-content/uploads/golfsoc/emails 

EMails templates can be customised as required by making a copy of the default 
template in the working folder with a new name and then editing this new 
template as required. This revised template can then be selected on the GolfSoc 
settings page. HTML templates (where included) have a border to fix the size of 
the document when printing, and it is recommended that this is retained when 
customising these email templates. See section 8.4 for further information on 
templates. 

Notes: 

• The default templates can be edited, but these edits will be lost when the 
plugin is updated or activated. 

8.2 Page Templates 

GolfSoc generates shortcode output based on page template files. The default 
template files are included in the GolfSoc distribution, and are copied to a working 
copy when the plugin is activated or updated. This copy of the template is located 
in the following working folder: 

{Your-site}/wp-content/uploads/golfsoc/html 

Templates can be customised as required by making a copy of the default 
template in the working folder with a new name, editing this new template as 
required and then selecting the new template in the plugin settings. See section 
8.4 for further information on the contents of template files. 

Custom page templates should be named as follows: 

Default template name: golfsoc_*******_HTML.php 

Custom template name: golfsoc_custom_*******_HTML.php 

8.3 EMail Logo Image 

The logo image which may be included in EMails can be customised to use a 
user defined image. The default image is included in GolfSoc distributions, and is  
copied to the following folder when the plugin is activated or updated: 

{Your-site}/wp-content/uploads/golfsoc/images 

To customise the Logo, create a new image in GIF, PNG or JPG format, transfer 
it to the above folder and then select the new image on the GolfSoc-Settings 
page. The default image is 180px by 34px but the customised image can be any 
size the user desires. 
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8.4 Template Files 

Template files are html files that include “tags” which are replaced by entries 
either from the GolfSoc settings or from the data extracted from the GolfSoc 
database. There are also conditional tags and tags that can be used to iterate 
through multiple data blocks. The template processor reads the template file and 
combines this with data extracted from the database to produce output. 

In the descriptions that follow {database-entry-name} is the name of a data 
element name. 

Note: All tags are case sensitive 

8.4.1 Settings Tags 

The following settings tags are available: 

[societyname] – Replaced by the organisation ID in the GolfSoc settings 

[url] – Replaced by the root URL of the website 

[logoimg] – Replaced by the logo image specified in the GolfSoc settings 

8.4.2 Database Tags 

The template processor replaces any tags that match an entry in the database 
with that entry from the database. The format of a database tag is as follows: 

[{database-entry-name}] 

8.4.3 Conditional Tags 

Template files can include conditional tags that control if a section of the template 
file is included depending on values in the data passed to them. The data 
element name will resolve to “True” if the data element exists and evaluates to a 
non-zero value. 

The following conditional tags are available: 

[if {database-entry-name}] 

[if not {database-entry-name}] 

[endif] 

8.4.4 Iterative Tags 

Template files can include iterative tags that will define a portion of the template 
file that will be repeated for each block of data passed to the template processor. 
This is typically where the data contains values for a number of players, 
competitions etc. 

The following iterative tags are available: 

[startloop] – Defines the start of the iterative loop 

[endloop] - Defines the end of the iterative loop 

8.4.5 Data Elements 

The data elements that are available in a specific context can be determined by 
setting the “Template Data” option in the GolfSoc settings (see section 4.1.7). 
With this option selected the data passed to the template processor will be 
included with the processed template. 
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9 Translation 

9.1 Overview 

GolfSoc supports the mechanism built into Wordpress for localisation of its text 
output. This mechanism uses a POT file (Portable Object Template), created by 
the plugin developer, to define the English language messages that can be 
generated by the plugin. This file is then used, by a translator, to create a PO file 
(Portable Object) which defines both the English language message and its’ 
translation in the target language. The PO file can then, if required, be bundled in 
with the plugin distribution to add the translation to the standard distribution. 

Wordpress uses the contents of the wp-content/languages folder to determine 
what languages are loaded, and the site language value on the General Settings 
admin page to determine the language for translations. 

9.2 Location of Language Files 

GolfSoc will check for language files in two directories. Firstly the Wordpress 
system language directory is checked. This directly is defined by the 
WP_LAND_DIR system constant. If a GolfSoc translation file is not located there, 
the ‘lang’ directory in the GolfSoc plugin folder is checked. This folder also 
contains all language files shipped with GolfSoc, so any custom language files 
stored here will be lost when GolfSoc is updated. 

9.3 Tools 

A number of tools exist to assist translators with the process of creating a PO file 
from a POT file. The plugin author recommends POEDIT, and open source cross-
platform tool which can be downloaded from http://www.poedit.net/. 

9.4 Translating With Poedit  

• Download a local copy of the golfsoc.pot file from the lang sub-folder of 
the GolfSoc plugin on your website. 

• Download, install and run POEDIT. 

• Click the “Open” button to display the open file dialogue. Select the “All 
Files” file filter, browse to the golfsoc.pot file and click open. 

• The main window shows a list of all source text entries, and their 
translations if one exits. When an entry is selected in the main window, 
the source text is shown in the window below the list, and the editable 
translation is shown in the window below that.  

• Items in the list may specify entries for singular and plural forms of the 
message. In this case the middle and bottom windows course multiple 
entries for the source text and translations. 

• Work through the source text list, adding translations in the bottom 
window as required. A summary of the total number of source text entries, 
and the number remaining un-translated is shown at the bottom of the 
window.  
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• To save your translations, click File → Preferences and on the Editor 
tab confirm that the Automatically compile .mo file on save box is checked 
(select this option and click OK if it is not). Then go to File → Save as… 
and save your translations as a PO file. The file name should be golfsoc-
ls_CC.po where ls is the language specified for the target language and 
CC is the country code. Complete lists of language codes can be found at 
http://en.wikipedia.org/wiki/List_of_ISO_639-1_codes and country codes 
at http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2. 

• Upload the golfsoc-ls_CC.mo file you have created to the lang sub-folder 
of the GolfSoc plugin on your website. 

9.5 Updating the .PO file 

When a new version of GolfSoc is released, new phrases may be added to, or 
existing phrases may be removed from the golfsoc.pot file. POEDIT can be used 
to incorporate these changes into an existing PO file, by following the instructions 
below. 

• Run POEDIT. 

• Click the “Open” button to display the open file dialogue. Browse to the 
PO file you wish to open and click open. 

• Select “Catalog => Update from POT file...” from the menu. Browse to the 
GolfSoc POT file (in the lang folder of the GolfSoc plugin) and click Open. 

• POEdit displays a dialogue with lists of the new phrases that have been 
added, and that have been deleted. View these lists as required and then 
click OK. 

• The untranslated phrases are listed at the top of the “Source Text” 
column. POEDIT may attempt to translate some phrases itself, and these 
are designated as “Fuzzy” translations, and these will follow the 
untranslated phrases in the Source Text column, and will be displayed in 
a different colour. 

• Add any new translations and the click save to update the PO file. 

 


